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Tutorials for Leapfrog Geo 5.0

These tutorials introduce basic concepts in Leapfrog Geo, such as setting up a project,
importing and working with data and building simple geological models. Download the tutorial
data at http://help.leapfrog3d.com/Tutorials/Geo/5.0/en-GB/LeapfrogGeoTutorialData.zip.

The data for the first tutorial is a Leapfrog Geo project that includes a series of saved scenes that
are used to introduce different aspects of using Leapfrog Geo. For subsequent tutorials, you will
import data and use it to build geological models.

The tutorials are:

l Tutorial 1: Introduction to Leapfrog Geo

l Tutorial 2: Modelling Veins

l Tutorial 3: Modelling a Syncline in a Series of Deposits

l Tutorial 4: Modelling a Complex Intrusion

l Tutorial 5: Building a Geological Model From a Map

When using Leapfrog Geo, you can find more information on the tools available by clicking on
the Help button that appears in manywindows:

Pressing the F1 key also displays help for the current window.
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Tutorial 1: Introduction to Leapfrog Geo

In this tutorial, we will work through an existing Leapfrog Geo project. This project includes a
series of saved scenes that demonstrate different aspects of using Leapfrog Geo.

1. Unzip the folder that contains the tutorial data and copy it to your hard drive.

The project file for this tutorial can be found in the Introduction folder and is called “Leapfrog
Geo Tutorial”.

2. Launch Leapfrog Geo.

The main window will appear with the Projects tab displayed.

The Recent projects list is a useful way of accessing the projects you are regularlyworking in.
Below the Recent projects list, the Search folder is displayed. This is useful if you have one
folder in which you will keep most of your Leapfrog Geo projects. Click on the folder button ( )
to change the Search folder. When there are Leapfrog Geo projects in the Search folder,
thumbnails for themwill be displayed.

3. In the Projects tab, clickOpen Project File:

4. Navigate to the folder where you saved the tutorial project files and click on the “Leapfrog
Geo Tutorial.aproj” file.

The project will be opened and Leapfrog Geo will display the Scene View tab.
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The Leapfrog Geo Main Window
The Leapfrog Geo main window is divided into three parts:

The Project Tree contains all the data in the project and tools for working with that data. When
you want to change how this data is used in the project, work with the objects in the project
tree.

The Scene View tab displays a 3D representation of selected objects from the project tree.
Changing how you view objects in the scene window does not change those objects in the
project tree.

Tools for changing the appearance of data in the scene window are available in the Shape List
and the Shape Properties Panel. Changing the appearance of these objects does not change
those objects in the project tree.

The series of folders in the project tree are used to organise objects such asmaps, images and
data sets into categories. These folders also provide tools that let you import information into
the project and generate models. Right-click on each folder to view the actions you can
performusing that folder.

You can add objects to the scene window by dragging them from the project tree. You can
temporarily hide them in the scene or remove themaltogether using the controls in the shape
list.
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The current viewing angle and scale are displayed in the lower right-hand corner of the scene
window. You can interact with the scene using the mouse or the keyboard:

Action Mouse Keyboard

Changing the
viewing angle

Click and drag to rotate the
scene

Press the arrow keys to rotate the scene

For smaller steps, hold down the Shift key while
pressing the arrow keys

Zooming in and out
of the scene

Use the scroll wheel

Hold the right mouse button
while moving the mouse

Press the Page Up or Page Down keys

For smaller steps, hold down the Shift key while
pressing the Page Up or Page Down keys

Panning the scene
Click and hold both mouse
buttons, then drag

Hold the scroll wheel and drag

Hold down the Alt key while pressing the arrow keys

Centre an object in
the scene

Click the scroll wheel

Click both mouse buttons
together

Practise rotating the scene using mouse, arrows and modifier keys. The viewing angle and scale
in the lower right-hand corner of the scene window change as you rotate the scene.

Toward the bottomof the project tree, the folder Saved Scenes and Movies contains a series of
sceneswe will look at in order to understand how Leapfrog Geo projectswork.

Saved scenes provide a stable point of reference in a project and can explain important
aspects of the project. Saving a scene does not save copies of the objects in the scene, it
simply saves settings relating to how the objects are displayed. Deleting objects from the
project will not preserve those objects in any saved scenes.

The project was last saved with the first scene, “1. Maps and topography”, displayed. If you have
changed the scene, you will need to redisplay the opening scene.
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1. Right-click on the “1. Maps and topography” scene in the Saved Scenes and Movies folder
and select Display:

The scene will be updated to show a “Topography” object and two images:

All objects in the shape list have a button ( ) that will remove the object from the scene. Most
objects also have a visibility button ( ) that can temporarily hide that object in the scene. It is
often easier to make an object temporarily invisible than to remove it from the list. Some objects
have an edit button ( ) that you can click to begin editing the object.

The shape list also contains options for changing the appearances of the object in the scene.
For the images, you can only change the opacity by adjusting the slider. For the topography, the
GIS data dropdown list provides additional display options.

2. Click on the GIS data dropdown and select None:
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The scene will be updated so that the Topography object is displayed using the Flat colour
option. In the case of surfaces, different colourswill be assigned to each side. The Topography
has an “Above” colour (yellow) and a “Below” colour (grey):

The colour used to display an object can be changed by clicking the colour chip. In the window
that appears, you can set a new colour or select frompredefined colours:

Many objects can also be displayed using other available data. For example, the Topography
includes elevation data and face dip data.

3. Click on Flat colour to view other display options:

Changing how you view objects in the scene window does not change those objects in the
project tree.
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4. Click on the ( ) button for each of the images in the shape list:

Removing objects from the scene by clicking the ( ) button does not remove them from the
project.

Only the topography remains in the scene.

The Z-Scale button in the lower right-hand corner of the main window lets you set a value
greater than 1.0 for the z-axis relative to the x- and y-axes. This is useful when the area under
study is very planar and extends over a wide area. In such cases, scaling the Z-axis can
accentuate the distribution of data along the z-axis.
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5. Click the Z-Scale button and experiment with different z-scale settings to see the effects:

6. Return the Z-Scale setting to 2.0.

Displaying GIS Data
The GIS data dropdown list includes a number of GIS data objects and images that have been
imported into the project. There are three ways to view imported GIS data and images:

l Display the objects independently of the topography. To view data in thisway, either
drag and drop the object into the scene or right-click on the object and select View
Object.

l Display objects draped on the topography.

l Display objects as part of a custom topography view.

To displayGIS data with the topography:

1. From the shape list, select the GIS data dropdown list and select GIS objects, then the lake_
bdy line.
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The topographywill be displayed with the GIS line draped on it using the Flat colour option:

The lake_bdy object can also be displayed using the columns available in the data table, which
can be selected from the view list:

The GIS data list also contains options for creating and displaying custom topography views:

2. Click on the GIS data dropdown list and select Views, then the “Topography+ GIS data”
option.
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The Topography will be displayed with map images and a number of GIS data objects draped
on it:

3. Click on the GIS data dropdown list and select Views, then the Edit views option.

4. In the window that appears, experiment with adding and removing layers and changing how
they are displayed:

The scene will be updated as you make changes in the Edit GIS Views window.

5. When you have finished, clickRevert All to discard your changes, then clickClose.

How Objects are Organised in the Project Tree
The way folders and objects are organised in the project tree lets you reveal or hide information
about an object to focus on objects you are currentlyworking with. This is also useful when you
are exploring a project and want to determine how something was put together. Leapfrog Geo
projects can be complex and the number of objects in the project tree can seemoverwhelming.
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The arrowsnext to objects in the project tree let you reveal or hide an object’s details to focus on
objects you are currentlyworking with. Let’s look at three objects in this project to see how this
works, the Topography object, a geological model and a static model.

In Leapfrog Geo, the topography is used to define the elevation of the ground’s surface. The
topography can be defined using a single digital terrain model (DTM), but often data from
several sources is combined to ensure the data is consistent.

The topography is used as the upper boundary for geological models and to position
GIS data. As a result, changing the topographywill cause geological models to be
recomputed and GIS data to be repositioned. This can be time-consuming, which iswhy it is
best to define the topography before GIS data is added to the project and before anymodels
are created.

To determine how the topographywas created, we need to find the topography in the project
tree.

1. Right-click on the Topography object in the shape list and select Go to Project Tree:

The Topography object ( ) in the Topographies folder is selected:

Objects displayed in bold in the project tree are those objects visible in the scene.

2. To see how the Topography was created, click on the arrow to expand it.
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The Topography was created froman imported DTM:

The object is hyperlinked because it is stored elsewhere in the project tree.

3. Click on the hyperlink to view the source object:

The imported DTM is stored in the Meshes folder.

Now let’s look at the components of a geological model.

4. Click on the Clear scene button ( ).

The Geological Models folder contains a model called “GM”.

5. Drag the “GM” model into the scene.

6. In the project tree, click the arrow for the model to expand it.
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7. Click the arrows for the model’sBoundary, Lithologies, Surface Chronology and Output
Volumes objects.

The five objects underneath the geological model “GM” represent the five basic parts of a
geological model:

l The Boundary object defines the outer limits of the geological model. It ismade up of a
basic “GM Extents” object, the Topography and a “North_boundary” object.

l The Fault Systemobject defines faults and their interactions in the geological model.
For thismodel, no faults are defined and so the object is empty.

l The Lithologies object defines the lithologies in the model. Because the model was
made fromdrillhole data, this object is hyperlinked to the imported drillhole data.

l The Surface Chronology object defines the structure of the model’s contact surfaces.
The contact surfaces are used to divide the model Boundary into the Output Volumes.

l The Output Volumes folder contains the generated units (outputs) that make up the
geological model.

8. Expand the objects under the Boundary object to see the data used to make the extents:
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The Topography object is included as the model’s upper boundary. The “North_boundary”
object was created using a GIS data object in the GIS Data, Maps and Photos folder. Clicking
on the hyperlinkswill locate the object fromwhich the extent was created.

Also in the Geological Models folder is another object, called “Static GM”.

9. Expand the Static GM model in the project tree:

The Static GM model ismade up of the same objects as the GM model, but most of these
objects cannot be edited. You can change the colours used to display the output volumes by
clicking on the Legend object.

10. Right-click on the Static GM model and select Properties.

In the window that appears, we can see the date the static model was created and information
about its volumes:

The Properties window is a useful way of finding out more information about objects in the
project. The information available in the Properties window dependson the type of object and
is available formost types of objects.

The Static GM model is a static copy of the GM model. Models in Leapfrog Geo will be updated
when changes are made to the data objects used to create them. A static copy, however, is a
snapshot of a model that does not change, even when changes are made to the data on which
the original model was dependent. A static copy is a useful way of storing historical models and
comparing models.

Exploring Additional Scenes
There are other saved scenes in the project that demonstrate different aspects of using
Leapfrog Geo, including:

l Displaying drillhole data

l Defining a model’s boundary

l Using the slicer to slice objects in the scene

l Using the moving plane to measure trends
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l Using the ruler to measure distances

l Creating and evaluating cross sections

Explore these saved scenes to see how different objects are managed in Leapfrog Geo. You can
display each saved scene by dragging it into the scene window. You can find out more about
each scene by viewing the comments. To do this, right-click on the saved scene in the project
tree. Any comments on the scene will be displayed along with the right-clickmenu:

In the next tutorial, we will import drillhole data and use it to build a geological model.
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Tutorial 2: Modelling Veins

In this tutorial, we will use drillhole data to build two geological models of a series of veins and
the lithologies in which they occur.

l For the first model, we will build individual veins.

l For the second model, we will build the veins as part of a vein system.

This tutorial also includes an introduction to setting up project files, importing topographical
and drillhole data and setting up a topography.

Data for this tutorial can be found in the Veins folder.

Setting Up the Project
To start:

1. Launch Leapfrog Geo.

The main window will appear with the Projects tab displayed:

2. In the Projects tab, clickNew Project.

The Create Project window will appear:

3. Enter the name “Veins tutorial” for the new project and clickBrowse to select a folder where
the project will be saved.

4. ClickOK to create the project.

The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing an Aerial Photo

When first created, a project has only a basic set of X-Y-Z coordinates, and the coordinate
systemused by the project is determined by the data imported to the project. It is not necessary
to specifywhat coordinate system is used; however, it is necessary to ensure that data you
import into the project uses the same coordinate system. Often, the best way to set the
coordinates for the project as a whole is to import a map or aerial photo. Adding georeference
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data to a map will set the location of the map in three-dimensional space and set the
coordinates for the project. For this project, we will import a georeferenced aerial photo.

Data for this tutorial can be found in the Veins folder.

1. Right-click on the GIS Data, Maps and Photos folder and select the Import Map option:

2. In the window that appears, select the file called orthophoto.tif, then clickOpen.

The Import Map tab then displays the image:

In thiswindow, you can enter georeferencing information for an image, if it is not included in
the image. In this case, the image includes georeference data and nothing needs to be
changed.

3. Click Import to import the photo.

The imported photo will be saved in the project tree in the GIS Data, Maps and Photos folder.
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4. Display the photo by clicking on it and dragging it into the scene:

The photo appears in both the shape list and the shape properties panel. There are three shape
list controls for the image:

l Click the visibility button ( ) to show or hide the photo.

l Click the ( ) to remove the image from the scene. This does not remove the image from
the project, as displaying objects and removing them from the scene do not change the
data.

l Adjust the photo’s opacity using the slider.

These controls appear formost objectswhen they are in the shape list. The visibility button ( )
and the opacity slider are useful when analysing relationships between objects in the scene.

Setting the Clipping Boundary

The clipping boundary is the part of the project space in which processing is carried out. When a
project is created, Leapfrog Geo automatically sets the clipping boundary. As data is added to
the project, the clipping boundary expands to fit that data. Formodelswith large data sets,
setting the clipping boundary to a fixed size will reduce the amount of time Leapfrog Geo
required for performing calculations.

For this project, we will set the clipping boundary to the area indicated by the imported aerial
photo.

1. Press the D key to view the photo fromabove.

2. Right-click on the Topographies folder and select Set Clipping Boundary.
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The Set Clipping Boundary window will be displayed, together with controls in the scene that
will help you to set the clipping boundary:

3. Use the handles in the scene to adjust the clipping boundary so it is slightly smaller than the
photo.

4. ClickOK.

Data subsequently imported into the project will be clipped to the clipping boundary.

Creating the Topography

In Leapfrog Geo, the topography is used to define the elevation of the ground’s surface. The
topography can be defined using a single digital terrain model (DTM), but often data from
several sources is combined to ensure the data is consistent.

The topography is used as the upper boundary for geological models and to position
GIS data. As a result, changing the topographywill cause geological models to be
reprocessed and GIS data to be repositioned. This can be time-consuming, which iswhy it is
best to define the topography before GIS data is added to the project and before anymodels
are created.

For this tutorial, a single DTM file will be used to define a topography. It is called topo.asc.

To define the topography from the DTM:

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the topo.asc file and open the file.
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The Import Elevation Grid window will be displayed:

3. Click Import.

The New Topography window will appear:

4. ClickOK to accept the default name and create the topography.

5. Click on the Clear scene button ( ) to clear any objects from the scene window.

6. Drag the newly-created topography into the scene.

The topography is displayed in three dimensions:
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7. Select the imported photo from the GIS data dropdown list:

The photo will now appear draped over the topography:

Importing the Drillhole Data
In Leapfrog Geo, drillhole data ismanaged using the Drillhole Data folder in the project tree.

Leapfrog Geo expects drillhole data that is stored in a collar table, a survey table and interval
tables. Each project can have only one set of drillhole data, made up of one collar file and one
survey file. Multiple interval tables can be imported, and a screens table can also be imported, if
available.

For this tutorial, there are three data files, which can be found in the Veins >Drillholes folder:

l collar.csv contains the collar definitions.

l survey.csv describes the deviation of each drillhole.

l lithology.csv contains the interval definitions that describes the lithology.

To start importing drillhole data:

1. Right-click on the Drillhole Data folder and select Import Drillholes.
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The Import Drillhole Data window will be displayed:

2. For the Collar, click on the Browse button to locate the tutorial file collar.csv.

3. Click on the file, then clickOpen.

When a collar file is added to the Import Drillhole Data window, Leapfrog Geo will look for
interval tableswith names such as “lithology” or “geology” in the same location and will add
them to the Interval Tables list. If an interval table file is not automatically added to the list,
clickAdd and browse for the required file.

In this case, all files have been added to the Input Files list:

4. Click on Import to start the process of importing data.
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First, the collar file is processed. Leapfrog Geo displays the data in the file and summarises how
each column will be imported:

Leapfrog Geo expects four columns for the collar data and attempts to match imported data
to these expected formats. For the collar file, Leapfrog Geo expects a drillhole identifier
(Hole ID) and the location of the top of the drillhole, in X, Y and Z coordinates. The Hole ID is
used to associate data in different tableswith a single drillhole. Inconsistencies in the way
drillholes are identified is a common source of errors.

5. Leapfrog Geo has correctlymapped the data in the collar file to the expected format. Click
Next to proceed to the next file.
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The survey file data is displayed:

Leapfrog Geo expects four columns for the survey data, a Hole ID and deviation depth,
azimuth and dip.

6. Leapfrog Geo has correctlymapped the data in the survey file to the expected format. Click
Next to proceed to the next file.

The interval table is displayed. The “lithology” column has been correctlymapped as lithology
data, but the “veins” column has not been mapped.
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7. In the Column Summary, click on the dropdown list for the “veins” column and select
“Lithology”:

The Column Summary is updated to indicate that the “veins” column will be imported as
lithology data:

8. Click on Finish to complete the process.

The data tableswill be added to the project tree as part of a new Drillholes object:

Leapfrog Geo automatically identifies and flags common drillhole data errorswhen drillhole
data tables are imported. There are three ways Leapfrog Geo marks tables that contain conflicts
or errors:
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l Tables containing errors are marked with a red X ( ). These errorsmust be fixed before
the affected drillholes can be used for processing.

l Numeric data columnswith non-numeric values are marked with a red X ( ), which
means that the rules that are used to handle non-numeric and negative values need to
be reviewed. If a drillhole has intervals that contain non-numeric and negative values,
the drillhole cannot be used for further processing until the rules are verified.

l Tables containing warnings are marked with a yellow exclamation mark ( ). Affected
drillholes can be used for further processing, but the information in the warning can
indicate that the data requires further attention. For example, if a warning indicates there
is data missing for a drillhole defined in the collar table, it may be that a drillhole has
been duplicated or that not all required data files have been loaded. Warnings are listed
along with table errors in the Database Errors window.

Until errors are corrected, the rows that contain those errors are excluded for all processing that
uses the table, including viewing in the scene. For example, if the ID for a collar position
contains an invalid coordinate, that collar will not be displayed in the scene as its location is not
known. Likewise, any processing will ignore data associated with this drillhole.

It isworth correcting errors as soon as possible, as correcting them later can result in significant
recomputation time.

For this tutorial, there is only a warning for the survey table that we will not correct.

Analysing the Data
Once Leapfrog Geo has imported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button ( ) to clear any objects from the scene window.

2. Display the data by dragging the Drillholes object into the scene:

3. Zoom in to get a better view of the data.
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Both the lithology table and the collar table are displayed and an entry for each appears in the
shape list:

The colours used to display the drillhole data will be different from those shown in these
images as colours are assigned randomlywhen data is imported.

Changing how the drillholes are displayed can help in analysing the data and making modelling
decisions.

Drillholes can be displayed as lines or as cylinders, which is controlled using the Make lines
solid button ( ) button.

4. Click the Make lines solid button ( ) to display the drillholes as cylinders:

The width of the cylinders can be changed in the shape properties panel:

5. If the drillhole cylinders are too large or too small, adjust the Line radius to a suitable value.
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6. Click the Show legend button ( ) for the table:

7. In the shape list, click the ( ) button to remove the collar table from the scene.

8. To get a better idea of how the layers are organised, click the Edit Colours button for the
lithology table:
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9. Click the visibility button ( ) for each of the vein lithologies to hide them in the scene:

Note that the legend is updated to reflect only the visible lithologies.

To select multiple lithologies, use the Shift or Ctrl keyswhile clicking. You can then change the
visibility of all selected lithologies by clicking one of the visibility ( ) buttons.

Hiding lithologies in thisway only changes how the data is displayed in the scene. Another
way of limiting the data displayed is to use a query filter, which can later be used in selecting
a subset of data for further processing.

We can see that the lithology layers, fromoldest to youngest, are:

l Schist B (purple)

l Schist A (yellow)

l Cover (green)

When building a geological model, it is best to define the contact surfaces by starting with the
oldest and working up. For this project, Schist B and Schist A are deposits and are the oldest
lithologies. They are then cross-cut by the vein lithologies, and the deposits and veins are
eroded byCover. Therefore, the best way to build thismodel is to:

l Model the deposits, Schist B and Schist A.

l Model the veins.

l Model the erosion.

10. Click the Cancel to close the Legend window.
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Creating the First Geological Model
To create the first geological model:

1. Right-click on the Geological Models folder and select New Geological Model.

2. In the window that appears, change the following settings:

l Set the Surface resolution to 50.

l From the Enclose Object dropdown, select the lithology table.

All settings can be changed after the model is created, except for the Base lithology
column. For the Surface resolution, Leapfrog Geo sets a value based on the data available,
but you can set a higher (coarser) value when you first create the model in order to reduce
processing time. Lower resolution values provide more detail, but surfaceswill take longer to
process.

3. ClickOK to create the geological model.

The new geological model will be created in the Geological Models folder:

l The Boundary object defines the limits of the geological model. When the model is first
created, this is the rectangularmodel extents. If a topography has been defined, it is
automatically used as the upper boundary.

l The Fault Systemobject defines faults and their interactions in the model.
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l The Lithologies object describes all the lithological units to be modelled in the
geological model and the colours that are used to display themon the screen. It is
generated automatically fromall the lithologies identified in drillhole data selected
when the model is created. If no column was selected, you will need to define the
lithologiesmanually before you start modelling the lithology layers.

l The Surface Chronology object describes the contact surfaces in the model, organised
in chronological order, fromyoungest to oldest. These surfaces and their chronology
determine how the volume inside the model extents is divided into lithological units.
When the model is first created, the Surface Chronology is empty, but it will eventually
hold all contact surfaces and inputs to them.

l The Output Volumes folder contains all the volumes generated in building the
geological model in chronological order, fromyoungest to oldest. When the model is
first created, the Surface Chronology is empty and so there is only a single output
volume that fills the model’s extents, called “Unknown”.

4. Double-click on the Lithologies object.

The Geological Modelwindow openswith the Lithologies tab displayed. The lithologies for the
new geological model include those from the drillhole data and the lithology “Unknown”:

5. ClickCancel to dismiss the Lithologies window.

6. Clear the scene.
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7. Display the geological model by right-clicking on it and selecting View Output Volumes.

At this point, the model is a single volume of lithology “Unknown”. In order to divide this
“Unknown” volume into volumes that represent known lithologies, we need to define the
model’s internal structure. This involves:

l Generating contact surfaces that correspond to the boundaries between lithological
units

l Refining the contact surfaces

l Arranging them in chronological order

l Using the surfaces and the chronological order to divide the geological model into units.

There are different types of contact surfaces that interact with other surfaces and volumes in
different ways:

l Deposit contact surfaces do not cut older volumes. A volume defined by a deposit
contact surface will, therefore, appear conformably on top of older volumes.

l Erosion contact surfaces cut other contact surfaces on the older side of the erosion
contact surface.

l Intrusion contact surfaces remove existing lithologies and replace themwith the
intrusive lithology on the younger side of the contact surface. Often, the older side of an
intrusion contact surface is labelled “Unknown” as typically intrusions displace multiple
older lithologies.

l Vein contact surfaces remove existing lithologies and replace themwith the vein
lithologywithin the boundaries defined by hangingwall and footwall surfaces and
points and a reference surface.

It is not always necessary to model geological formations according to their corresponding
contact surface type. For example, it might make sense to model basement granite as a deposit
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rather than as an intrusion when it forms the lowest layer in a geological model: if there are no
older layers for an intrusion-type contact surface to remove and it is apparent from the drillhole
data that the lithology simply fills the lowermost parts of the model, then it makes sense to
model it as a deposit.

See the topic Contact Surfaces in the Leapfrog Geo online help formore information on the
different types of contact surface and how they interact.

For the geological model in this tutorial, however, we can model each lithology according to
the corresponding contact surface type.

Modelling the Deposit Contact Surfaces

In Analysing the Data, we saw that the oldest lithologies in the drillhole data are two deposits:

l Schist B

l Schist A

The first contact surface we will model is the oldest (lowest), Schist B, and we will model it as a
deposit.

1. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology:
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2. In the window that appears, select “Schist B” from the Select primary lithology dropdown
list:

We saw in Analysing the Data that Schist B contacts Schist A, so we want to build a surface that
represents the contacts between Schist B and Schist A. Therefore, we will keep Schist A in the
Contacting/Avoiding lithologies list. The veins, however, are younger lithologies than Schist B
and Schist A, so we want to ignore them.
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3. Drag each of the vein lithologies to the Ignored lithologies list:

4. ClickOK.

The new contact surface will appear in the project tree under the Surface Chronology.

5. Expand the contact surface to view the objects used to create it:

Note that the contact surface ismarked as inactive. When you create a contact surface, it
appears in the project tree under the Surface Chronology object, but it is not enabled and,
therefore, does not affect the geological model volumes. Thismeans you can work on the
surface without having to reprocess the model whenever you make a change to the surface.
In Leapfrog Geo, you can easily define, enable and remove contact surfaces froma model,
and you can experiment with modelling lithologies using different techniques in order to
arrive at a geologically reasonable model.

6. Clear the scene.

7. Add the new contact surface ( ) to the scene, together with the points ( ) and segments ( )
used to create it.

8. Display the legend ( ) for the segments.
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The segments ( ) show how the lithologies in the drillhole data have been handled in order to
create the contact surface:

The underside of the contact surface is Schist B (pink) and the top side is Schist A (red).

9. Double-click on the Surface Chronology.

The Geological Modelwindow will be opened with the Chronology tab displayed.

10. Tick the box to enable the contact surface:

11. ClickOK.

12. Once the changes have been processed, drag the Output Volumes folder into the scene.
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The Schist B output volume ( ) has filled the space indicated as the primary lithology:

The lithology on the younger side of the contact surface has been used to fill the remainder of
the model space.

When you right-click on the geological model in the project tree, there are three ways to view it:

l View Object adds the geological model to the shape list as a single object. You can also
display the model in thisway by dragging it into the scene.

l View Output Volumes adds the volumes in the Output Volumes folder to the scene.
You can also display the model in thisway by dragging the Output Volumes folder into
the scene.

l View Surface Chronology adds the model’s surfaces to the scene.

Modelling the Veins

Veins can be modelled as individual contact surfaces or as a vein system. When the drillhole
data has the veins sorted into individual lithologies, it is best to model veins one-by-one.

1. Clear the scene.

2. Right-click on the Surface Chronology object and select New Vein > From Base Lithology.

3. In the window that appears, select “Vein A”:
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4. ClickOK.

The new vein surface will appear in the project tree under the Surface Chronology.

5. Expand the vein to view the objects used to create it:

The vein ismade up of:

l Hangingwall and footwall surfaces ( ), which, when expanded, show the hangingwall
and footwall data objects used to create the surfaces.

l Vein segments and pinch out segments ( ) extracted fromdrillhole data. These are only
included when a vein is created from lithology contacts and are disabled when the vein
is first created.

l A reference surface ( ) calculated as the best fit surface using the hangingwall and
footwall surfaces.

l A boundary object ( ), which is emptywhen the vein is first created.

6. Drag the vein into the scene and make it partly transparent.

7. Expand the hangingwall and footwall surfaces surfaces ( ) and add their points objects ( )
to the scene.

The scene will appear similar to this:
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We can see that the vein extendswell beyond the Vein A hangingwall and footwall points.

8. Expand the geological model’sBoundary object (not the vein boundary) and add the GM
Extents object to the scene.

9. Press the D key to view the scene fromabove.

10. Zoomout to view the GM Extents in relation to the vein:

The problemwith the shape of the vein is that it extends to the model boundary, in spite of the
hangingwall and footwall points being restricted to the centre of the model.

Vein walls can be set to pinch out where drillhole data indicates they do not occur. This is
achieved by creating ‘outside’ intervals on drillholes that do not have an interior vein segment.
These intervals are then flipped with respect to interior vein intervals, which, in effect, means the
footwall and hangingwall orientation has the opposite sense to the nearest interior intervals.
This forces the hangingwall and footwall surfaces to cross, thereby pinching out. These
pinchout points can be viewed in the scene and edited, if necessary.

11. Double-click on the vein ( ) in the project tree.
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12. In the Edit Vein window, click the Surfacing tab, then tick the box to enable the Pinch out
option:

13. ClickOK.

When the changes have been processed, the revised vein will appear in the scene:

The vein now pinches out and no longer occurswhere there is no Vein A in the drillhole data.

14. Create veins B, C and D in the same manner, enabling pinch outs.

15. Clear the scene, then add the veins to it.
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The scene should appear similar to this:

At this point, we have changed the vein settings so the veins are a more realistic shape. However,
they are not yet enabled in the geological model.

16. Double-click on the Surface Chronology.

17. Enable each vein and arrange themso they appear in the following order:

18. ClickOK.

19. Clear the scene.

20. Once the model has been processed, add the Output Volumes folder to the scene.

21. While holding down the Ctrl key, click on Schist A and Schist B in the shape list.
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22. Drag the opacity slider to make the deposits partly transparent:

To see how the veins cut the deposits:

23. Remove all the volumes except Schist B from the scene.

24. Make Schist B opaque.

The scene should appear similar to this:

Modelling the Erosion Contact Surface

The final step in building the model is to create the last contact surface, Cover, which will be
modelled as an erosion contact surface.

1. Right-click on the Surface Chronology object and select New Erosion > From Base
Lithology.
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2. In the window that appears:

l Select “Cover” from the Select primary lithology dropdown list.

l Click the Use contacts below button.

AsCover is the uppermost lithology in the model, we need to select contacting lithologies from
the contacts below. Both Schist A and Vein A appear in the Contacting/Avoided lithologies list:

When we created the deposit contact surface, we ignored the vein lithologies because they
were younger than the depositswe were modelling. Here, however, Vein A is older than Cover
and so we will keep it in the Contacting/Avoided lithologies list.

The other lithologies, however, appear in the Ignored lithologies list because there are no
contacts between those lithologies and Cover. Thismight not always be the case. For example,
when drillhole data is appended, there could be contacts between Cover and these other
lithologies. Because Cover is younger than all other lithologies, we need to move the lithologies
in the Ignored lithologies list into the Contacting/Avoided lithologies list.

3. Drag each lithology from the Ignored lithologies list into the Contacting/Avoided
lithologies list.

4. ClickOK.

Once a contact surface has been created, it is a good idea to view it in the scene to ensure it is as
expected.

5. Clear the scene.

6. Add the new contact surface to the scene.

7. Add the lithology table to the scene.
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The scene should appear similar to this:

8. Double-click on the Surface Chronology.

Because we’ve defined the contact surfaces fromoldest to youngest, the Cover contact surface
appears in the Surface Chronology as the youngest lithology, so there is no need to change the
chronology.

9. Enable the erosion contact surface.

10. ClickOK.

11. Clear the scene.

12. Once the changes have been processed, add the Output Volumes folder to the scene.

The erosion contact surface has cut away the deposits and veins:

13. Press the D key to view the scene fromabove.

© 2019 Seequent Limited



Using a Vein System | 45

14. Click the Show slicer button ( ).

15. Click on the slicer in the shape list.

16. In the shape properties panel, click on the Set to button and select Elevation (Z) Axis:

With the slicer tool selected, hold the Ctrl key and the right mouse button to change the
position of the slicer in the scene:

Using a Vein System
There are two ways of modelling veins in Leapfrog Geo:

l Model individual veins. This is the approach we used for the first geological model. The
veins interact with one another and with other lithologies as defined by the Surface
Chronology.

l Model a vein system. The vein system represents a single lithologywithin the geological
model. How the veins interact with one another is determined by settings in the vein
system, and how the vein systemas a whole interactswith other lithologies is determined
by the Surface Chronology.
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The lithology table in the drillhole data imported in Importing the Drillhole Data has two
columns:

l The “lithology” column contains the two deposits (Schist A and Schist B), the erosion and
four vein lithologies.

l The “veins” column contains the two deposits, the erosion and a single “Veins” lithology
that represents all the veins.

In order to model a vein system, we will create a new geological model using this “veins” column
and model the veins as part of the vein systemusing the data in the “lithology” column.

To start:

1. Clear the scene.

2. Right-click on the Geological Models folder and select New Geological Model.

3. In the window that appears, change the following settings:

l Select the “veins” column for the Base lithology column.

l Set the Surface resolution to 50.

l From the Enclose Object dropdown, select the lithology table.

l Name the model “Vein systemGM”.

4. ClickOK to create the geological model.

Creating the Vein System

For thismodel, we won’t model the deposit and erosion contact surfaces, but will onlymodel
the vein system.

1. Right-click on the Surface Chronology and select New Vein System.
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2. In the window that appears, select “Veins” for the Vein lithology:

Because veins usually contact multiple lithologies, leave the Outside lithology set to
“Unknown”.

3. ClickOK.

The new vein systemwill appear under the Surface Chronology. It is empty and inactive.

Creating the Veins

Next, we will define each vein using the lithology data from the “lithology” column.

1. Right-click on the vein systemand select New Vein > From Other Contacts.

2. In the window that appears, select the “lithology” column.

3. ClickOK.

4. In the New Vein window, select “Vein A”, then clickOK.

The new vein will be added to the project tree as part of the vein system.

5. Expand the vein systemand add the new vein to the scene.

We need to enable pinch-outs for the vein in order to achieve a realistic shape.

6. Double-click on the vein ( ) in the project tree.
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7. Click on the Surfacing tab and enable the Pinch out option:

8. ClickOK.

When the changes have been processed, the revised vein will appear in the scene.

9. Create veins B, C and D in the same manner, enabling pinch outs.

10. Clear the scene, then add the vein system to it.

The vein systemappears in the shape list, but there is nothing in the scene aswe need to enable
the veins in the vein systemand set their interactions.

Setting the Vein Interactions

We can determine how the veins interact by displaying them in the scene.

1. Clear the scene, then add each of the veins to it.

2. Press the D key to view the scene fromabove.

3. Click on the second vein down, as shown:
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This is Vein A, which will we consider the central vein. In order to determine the interactions
between Vein A and the other veins, we need to know which side of Vein A is the hangingwall
and which side is the footwall. We can do this by adding Vein A’s hangingwall and footwall
points to the scene.

4. Expand Vein A in the project tree to view the points that make up the hangingwall and
footwall surfaces:

5. Add the hangingwall and footwall points ( ) to the scene.

6. Click the Show legend button ( ) for the footwall points:

The other veins interact with Vein A as follows:

l Veins B and D terminate against Vein A on Vein A’s hangingwall side.

l Vein C terminates against Vein A on Vein A’s footwall side.

Now we can set the interactions for the vein system.

7. Double-click on the vein system in the project tree.
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8. Click on the Vein System tab:

The veins appear in the Vein priority list in the order in which theywere defined. Because Vein A
is already at the top of the list, we don’t need to change the order.

Vein A is the highest priority vein in the list, and so no interactions can be set for it.

9. Click on Vein B and click the Add button.

Only veins that are higher in priority than the selected vein will appear in the Vein list, so the
correct vein has been selected. The Side is also correct:

10. Click on Vein C, then on the Add button.
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11. Select “Foot wall” for the Side:

12. Click on Vein D, then on the Add button.

Again, the default interaction is correct.

13. Tick the box for each vein to enable them in the vein system, then clickOK.

14. Clear the scene.

15. Add the vein system to the scene:

The vein systemappears in the scene as a single lithology.

© 2019 Seequent Limited



52 | Leapfrog Geo Tutorials

If all four veins do not appear in the scene, it is likely that the interactions have not been set
correctly. If this is the case, the affected vein will appear in the project tree as empty:

Double-click on the vein or the vein system to correct the interaction. Here, double-clicking
on the vein opens the Edit Vein window:

Enabling the Vein System in the Model

Although the vein system is now complete, we still need to enable it in the model.

1. Double-click on the Surface Chronology.

2. Enable the vein systemand clickOK.

3. Clear the scene.

4. Add the output volumes to the scene.

5. Press the D key to view the scene fromabove.

6. Click the Show slicer button ( ).

7. Click on the slicer in the shape list.

8. In the shape properties panel, click on the Set to button and select Elevation (Z) Axis.
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With the slicer tool selected, hold the Ctrl key and the right mouse button to change the
position of the slicer in the scene:

Because we haven’t defined the lithologies outside the vein system, lithology “Unknown” is
used. Compare the vein systemwith the individual veinsmodelled as part of the GM model.
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Tutorial 3: Modelling a Syncline in a Series of
Deposits

In this tutorial, we will use drillhole data to build a model of a syncline in a banded iron
formation. Whereas in Tutorial 2: Modelling Veins we modelled the contact surfaces
individually, for this tutorial, we will model a series of deposits using a stratigraphic sequence.

Data for this tutorial can be found in the Syncline folder.

Setting Up the Project
To start:

1. Launch Leapfrog Geo.

2. In the Projects tab, clickNew Project.

3. Enter the name “Syncline tutorial” for the new project and clickBrowse to select a folder
where the project will be saved.

4. ClickOK to create the project.

The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing a Photo and Setting the Clipping Boundary

First, we will import an aerial photo and use it to set the clipping boundary. The file is called
“photo.tif”.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called photo.tif, then clickOpen.

3. Click Import to import the photo.

4. Add the photo to the scene and press the D key to view it fromabove.

5. Right-click on the Topographies folder and select Set Clipping Boundary.
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6. From the Enclose Object list, select <Everything>:

7. ClickOK.

Importing the Drillhole Data

Data for this part of the tutorial can be found in the Syncline >Drillholes folder. There are three
files:

l collar.csv contains the collar definitions.

l survey.csv contains information that describes the deviation of each drillhole.

l geology.csv contains the interval definitions that describes the lithology.

1. Right-click on the Drillhole Data folder and select Import Drillholes.

The Import Drillhole Data window will be displayed.

2. ForCollar, click on the Browse button to locate the tutorial file collar.csv.

3. Click on the file, then clickOpen.

All files have been added to the Input Files list.

4. Click on Import to start the process of importing data.

5. Leapfrog Geo correctlymaps the data in the collar and survey files, so clickNext for each
one.

6. For the geology table, click on Finish to complete the process.

The data tableswill be added to the project tree.

Now that we have imported the drillhole data, we can use it to create the topography.
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Creating the Topography

In Tutorial 2: Modelling Veins, we created the topography froman elevation grid. For this
tutorial, we have no topography data, so we will use the collar points in the drillhole data.

A key advantage of defining a topography is that it provides consistent elevation data for
objects imported to and created in the project. The quality of elevation information can be
poor compared to X- and Y-coordinates, which can create problemswhen using objects to
build a model. A topography can be created from the most reliable elevation data, and other
objects can have elevation set from this topography.

1. Right-click on the Topographies folder and select New Topography > From Points.

All points object available in the project will be listed, which, in this case, is only the imported
collar points:

2. ClickOK.

3. In the New Topography window, clickOK to accept the default name and create the
topography.

Analysing the Data
Once Leapfrog Geo has imported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button ( ) to clear any objects from the scene window.

2. Add the geology table to the scene.

3. Click the Make lines solid button ( ) to display the drillholes as cylinders.

4. Adjust the Line radius in the shape properties panel, if required.

5. Click the Show legend button ( ) for the table.

6. Zoom in to get a better view of the data.
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The scene should appear similar to this:

The lowest layer in the model isGranite, which we can model as a deposit, and the highest layer
isGravel. Although we could model the deposit contact surfaces one-by-one, the layers are
roughly continuous, which lends itself to modelling using a stratigraphic sequence. Therefore,
we will model the layers by defining a stratigraphic sequence that hasGranite as the lowest
layer and Gravel as the highest.

Creating the Geological Model
To create the geological model:

1. Right-click on the Geological Models folder and select New Geological Model.

2. In the window that appears, change the following settings:

l Set the Surface resolution to 50.

l From the Enclose Object dropdown, select the geology table.

3. ClickOK to create the geological model.

The new geological model will be created in the Geological Models folder.

Defining a Stratigraphic Sequence
To create the stratigraphic sequence:

1. Right-click on the model’s Surface Chronology and select New Stratigraphy.
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2. In the window that appears, select Gravel for the Lithology Above and Granite for the
Lithology Below:

3. Click the Add Lithologies button.

4. Click the Lithology box to select all the lithologies:

5. ClickOK.
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The lithologies have been added to the Stratigraphic Lithologies list:

6. ClickOK.

7. Clear the scene.

8. When Leapfrog Geo has finished generating the stratigraphy, add it to the scene:
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9. Expand the stratigraphic sequence in the project tree:

The stratigraphic sequence object contains its own series of contact surfaces that can be
worked with in the same manner as contact surfaces that are created one-by-one.

If there were errors in the sequence, it would include a set of points that can be used in fixing
the errors. For example, here the stratigraphic sequence has errors, which appear in the project
tree as a pinch-out errors object ( ):

These errors usually occur because a layer is not continuous, whereas Leapfrog Geo expects
that layers included in a stratigraphic sequence are continuous. Adding the pinch-out-errors
object ( ) to the scene displays the points that are causing errors. You can also find out more by
right-clicking on the stratigraphic sequence and selecting List Errors:

Together with the pinch-out errors, this information can be used to decide what lithologies to
remove from the sequence orwhat surfaces to adjust.

However, for this tutorial there are no errors, and we can move on to the next step.

The sequence is not yet enabled in the model.
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10. Double-click on the Surface Chronology object.

11. Tick the box for the stratigraphic sequence to enable it:

12. ClickOK.

13. Clear the scene.

14. Add the model’s output volumes to the scene:
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Adding a Fault to the Model
The data for this tutorial includes a GIS line for a fault. We will now import the GIS line and add
the fault to the model.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Vector Data.

2. In the window that appears, select the Fault.shp file and clickOpen.

3. In the window that appears, clickOK.

4. When prompted to filter data, select the Don’t Filter Data option.

The line will be imported to the project:

l The imported line is added to the GIS Data, Maps and Photos folder.

l A copy of the line is draped onto the topography and added to the Draped GIS Objects
folder in the Topographies folder.

Now we can add the fault to the geological model’s Fault System.

Each geological model is created with a Fault Systemobject that is used to construct faults and
manage their interactions. Once the faults are active in the geological model, the geological
model will be divided into separate fault blocks, which will appear in the project tree as part of
the model.

5. Right-click on the geological model’s Fault System and select New Fault > From GIS Vector
Data.

Two options are given for using the fault GIS line. Using the (On Topography) option makes
sense for GIS data as it is, by nature, on the topography. The (On Topography) option also
mitigates any issues that may occur if elevation information in the GIS data object conflictswith
that in the project.

6. Select “Fault (On Topography)” and clickOK:

The GIS line will be added to the Fault System but is not activated in the geological model.

7. Double-click on the Fault System.

In the Fault Systemwindow, all faults defined for a model are listed and you can set
interactions between these faults. For thismodel, however, there is only one fault and no
interactions need to be set.
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8. Tick the box for the fault and clickOK:

9. Once the geological model has been reprocessed, add it to the scene:

Note that the way the geological model is organised in the project tree has changed now that
the fault has been activated:
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The geological model has been split into two fault blocks. Each fault block has its own Surface
Chronology, whereas the top-level geological model has none. The Surface Chronology for
one fault block can be modified without affecting other fault block.

For geological modelswith a fault system, you can model the contact surfaces in two ways:

l Define the Surface Chronology before enabling the Fault System. All surfaces defined
for the unfaulted model will automatically be copied to each fault block. Some surfaces
defined for the model as a whole will not occur in every fault block, which can be
corrected byworking with the surfaces in each fault block.

l Enable the Fault System before any surfaces are defined in the unfaulted model, then
define the Surface Chronology for each fault block. An aid to working with a faulted
model in thisway is the ability to copy contact surfaces fromone faulted block to
another. To copy a Surface Chronology fromone fault block to another, right-click on
the chronology you wish to copy and select Copy Chronology To.

Which approach is best dependson the model being built. You may already know where the
faults are and choose to define themand subdivide the geological model before defining any
lithology layers. On the other hand, sometimes it is not apparent where the faults are until the
layers have been built, in which case you can add the new fault, activate it in the model, then
workwith the surfaces in each fault block.

When working with fault blocks, it can be useful to rename them. For thismodel, we will
rename the fault blocks “north block” and “south block”.

10. Clear the scene.

11. Right-click on the geological model in the project tree and select View Fault Block
Boundaries.

12. Click on one of the fault blocks in the scene:

The name of the fault block is shown in the scene selection window.

13. In the project tree, find the fault block.

14. Right-click on the fault block and select Rename.

15. Enter the new name and clickOK.
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Tutorial 4: Modelling a Complex Intrusion

In this tutorial, we will model a systemof complex intrusions, which are shown in cross section
below:

When a geological model is first created, it is a single volume of lithology “Unknown”. This
Unknown volume is divided up into known lithologies by creating contact surfaces. Contact
surfaces interact with other surfaces in different ways, and understanding how the contact
surfaces interact helps in making decisions on how to model formations.

Types of contact surfaces are:

l Deposit contact surfaces. These do not cut older volumes. A volume defined by a
deposit contact surface will, therefore, appear conformably on top of older volumes.

l Erosion contact surfaces. These remove lithologies on the older side of the erosion
contact surface.

l Intrusion contact surfaces. These remove existing lithologies and replace themwith the
intrusive lithology on the younger side of the contact surface. Often, the older side of an
intrusion contact surface is labelled “Unknown” as typically intrusions remove multiple
older lithologies.

l Vein contact surfaces. These remove existing lithologies and replace themwith the vein
lithologywithin the boundaries defined by hangingwall and footwall surfaces and
points and a reference surface.
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Here, three deposit contact surfaces interact with two intrusion contact surfaces. The intrusion
contact surfaces are white (Unknown lithology) on the outside and the intrusive lithologies (I1
and I2) on the inside:

Intrusion contact surfaces result in rounder shapes than deposit and erosion contact surfaces,
which tend to be flat and sheet-like.

The difference between deposit and erosion contact surfaces is how they interact with older
lithologies.

l Deposits appear conformably on top of underlying older volumes and do not occur in
regions defined by older deposits.

l Erosions, however, remove existing lithologies on the older side of the erosion.

Here, two deposit contact surfaces divide a model volume (bounded by the pink box) into three
lithologies; each deposit (A, B and C) lies conformably on top of the previous one:

When a third deposit contact surface is added, lithologyD is deposited on top of lithologies B
and C:
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If, however, the third surface is an erosion contact surface, it cuts away the deposits on the older
side:

An intrusion contact surface enabled in the model will remove the existing lithologies and
replace themwith the intrusive lithology. Here, an intrusion surface (E) added to the model as
the youngest surface cuts away the older lithologieswherever it occurs:

It is not necessary to model geological formations according to their corresponding contact
surface type. Often, the way you model a contact surface dependson the shape suggested by
the data and your knowledge of the geology of the area being modelled.

See the topic Contact Surfaces in the Leapfrog Geo online help formore information on the
different types of contact surface and how they interact.

Setting Up the Project
Data for this tutorial can be found in the Intrusion folder.

To start:

1. Launch Leapfrog Geo.

2. In the Projects tab, clickNew Project.

3. Enter the name “Intrusion tutorial” for the new project and clickBrowse to select a folder
where the project will be saved.

4. ClickOK to create the project.

The project will be created and Leapfrog Geo will display the Scene View tab for that project.
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Importing a Map and Setting the Clipping Boundary

First, we will import a map and use it to set the clipping boundary. The file is called map.tif.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called map.tif, then clickOpen.

3. Click Import to import the map.

4. Add the map to the scene and press the D key to view it fromabove.

5. Right-click on the Topographies folder and select Set Clipping Boundary.

6. From the Enclose Object list, select <Everything>:

7. ClickOK.

Creating the Topography

As in Tutorial 2: Modelling Veins, we will create the topography froman elevation grid. The file
is called oamaru.asc.

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the oamaru.asc file and open the file.

3. In the Import Elevation Grid window, click Import.

4. In the New Topography window, clickOK.

Importing the Drillhole Data

Data for this part of the tutorial can be found in the Intrusion >Drillholes folder. There are three
files:

l collar.csv contains the collar definitions.

l survey.csv contains information that describes the deviation of each drillhole.
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l geology.csv contains the interval definitions that describes the lithology.

1. Right-click on the Drillhole Data folder and select Import Drillholes.

The Import Drillhole Data window will be displayed.

2. ForCollar, click on the Browse button to locate the tutorial file collar.csv.

3. Click on the file, then clickOpen.

All files have been added to the Input Files list.

4. Click on Import to start the process of importing data.

5. Leapfrog Geo correctlymaps the data in the collar and survey files, so clickNext for each
one.

6. For the geology table, click on Finish to complete the process.

The data tableswill be added to the project tree.

Analysing the Data
Once Leapfrog Geo has imported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button ( ) to clear any objects from the scene window.

2. Add the geology table to the scene.

3. Click the Make lines solid button ( ) to display the drillholes as cylinders.

4. Click the Show legend button ( ) for the table.

5. In the shape properties panel, change the Line radius to make the drillholesmore visible.

6. Zoom in to get a better view of the data.

The scene should appear similar to this:
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The drillholes away from the centre of the data have two lithologies, Basement and Volcanic
edifice. These are the lowest layers in the model and we will model themas deposits.

7. Click the Edit Colours button.

8. In the Legend window, hide the Basement and Volcanic edifice lithologies:

9. ClickOK to dismiss the window.

10. Press the E key to view the scene looking east.

The two lithologies are hidden in the scene and it is easier to view the drillholes at the centre of
the data. Note that the legend in the scene has been updated to reflect the hidden lithologies:

Fromoldest to youngest, the lithologies are:

l Propylitic alteration

l Mineralised potassic alteration

l Porphyry stock

l Sericitic alteration
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l Chloritic alteration

l Advanced argillic alteration

l Acid leached zone

11. Click the Edit Colours button.

Keep the Legend window open and move it away from the scene window to view different
lithologies in the scene.

12. In the Legend window, hide lithologies so that only the Propylitic alteration, Mineralised
potassic alteration and Porphyry stock lithologies are visible:

The propylitic alteration, mineralised potassic alteration and porphyry stock lithologies are
concentrated at the centre of the data. Because the drillhole data suggests a rounder shape for
these lithologies, we will model themas intrusion contact surfaces. These lithologies are
approximately the same age, but when we add them to the Surface Chronology, we need to
decide on an order. We can work from the outer edges of the model in, which is in the following
order:

l Propylitic alteration

l Mineralised potassic alteration

l Porphyry stock

The remaining lithologies are:

l Sericitic alteration

l Chloritic alteration

l Advanced argillic alteration

l Acid leached zone
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13. In the Legend window, hide lithologies so that the Acid leached zone, Advanced argillic
alteration, chloritic alteration and sericitic alteration lithologies are visible:

These four lithologies are flatter and appear in more drillholes than the earlier intrusions, and
we can model themusing deposit or erosion contact surfaces.

We will build thismodel by:

l Modelling the earliest lithologies, basement and volcanic edifice, as deposits.

l Modelling propylitic alteration, mineralised potassic alteration and porphyry stock
lithologies as intrusions.

l Modelling the remaining lithologies as a series of deposits and erosions.

Creating the Geological Model
To create the geological model:

1. Right-click on the Geological Models folder and select New Geological Model.

2. In the window that appears, change the following settings:

l Set the Surface resolution to 20.

l Tick the box forAdaptive.

l From the Enclose Object dropdown, select the geology table.

3. ClickOK to create the geological model.

The new geological model will be created in the Geological Models folder.
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Modelling the Deposit Contact Surfaces
In Analysing the Data, we saw that the oldest lithologies in the drillhole data are two deposits:

l Basement

l Volcanic edifice

The first contact surface we will create is the Basement contacts.

1. Clear the scene.

2. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology.

3. In the window that appears, select “Basement” from the Select primary lithology dropdown
list.

We want to build a surface that represents the contacts between Basement and Volcanic
edifice and that excludes younger lithologies.

4. Drag the Sericitic alteration contacts and the Propylitic alteration contacts to the Ignored
lithologies list:

To select multiple items in windows and in the project tree, hold the Ctrl key or the Shift key
while clicking.

5. ClickOK.

The new contact surface will appear in the project tree under the Surface Chronology.

6. Add the geology table to the scene.
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7. In the shape list, click the Edit Colours button for the geology table.

8. Hide all lithologies except Basement and Volcanic edifice.

9. Add the new contact surface to the scene and rotate the scene to view the drillholes and the
surface:

Note that Leapfrog Geo has labelled the surface as Basement on the underside (the older side)
and Volcanic edifice on the top side (younger).

10. Clear the scene.

11. Double-click on the Surface Chronology.

12. Tick the box to enable the contact surface:

13. ClickOK.

14. Once the changes have been processed, add the model to the scene.
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The contact surface has divided the Unknown volume into known lithologies Basement and
Volcanic edifice:

Modelling the Intrusions
The next step is to model the propylitic alteration, mineralised potassic alteration and porphyry
stock lithologies. As discussed in Analysing the Data, we will work from the outer edges of the
model inward:

l Propylitic alteration

l Mineralised potassic alteration

l Porphyry stock

1. Clear the scene.

2. Right-click on the Surface Chronology object and select New Intrusion > From Base
Lithology.
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3. In the window that appears, select Propylitic alteration:

We need to move all younger lithologies into the Ignore (Younger lithologies) list. The easiest
way to do this is to move all the lithologies into the Ignore (Younger lithologies) at once, then
add the lithologieswe want to the Exterior lithologies list.

4. Click in the Exterior lithologies list.

5. On the keyboard, pressCtrl+A.

6. Drag all lithologies into the Ignore (Younger lithologies) list.

The lithologies in the Exterior lithologies list should be those that the intrusive body cuts
through, which will be the older lithologies.

7. Double-click on Basement and Volcanic edifice to add themback into the Exterior
lithologies list:

8. ClickOK.

The new contact surface will appear in the project tree under the Surface Chronology.

9. Add the new contact surface ( ) to the scene, together with the points ( ) and segments ( )
used to create it.
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It is coloured on the inside with the intrusive lithology and on the outside with the lithology
Unknown:

This is typical of intrusive lithologies as they contact multiple other lithologies on the outside.

10. Repeat steps 2 to 9 for the Mineralised potassic alteration and Porphyry stock lithologies,
being sure to keep older lithologies in the Exterior lithologies list:

l For the Mineralised potassic alteration intrusion, the Exterior lithologies will be
Basement, Volcanic edifice and Propylitic alteration.

l For the Porphyry stock intrusion, the Exterior lithologies will be Basement, Volcanic
edifice, Propylitic alteration and Mineralised potassic alteration.

It is a good idea to check each surface as is it created by adding the surface to the scene,
together with the data objects used to create it.

11. Clear the scene.
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12. Add all new intrusions to the scene:

The Propylitic alteration appears geologically reasonable, but the other two surfaces do not.
We need to give thema more vertical appearance, and the best way to do this, in the absence of
additional data, is to apply a trend to the surface.

Often the easiest way to apply a trend is to position the moving plane in the scene and use it as a
reference plane for the trend we will apply to a surface.

13. Remove the Propylitic alteration and Porphyry stock contact surfaces from the scene.

14. Press the E key to view the scene looking east.

15. Click on the Draw plane line button ( ) in the toolbar and draw a line roughly vertical in the
scene:

16. Rotate the scene to view the plane properly.
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17. Click on the plane to view its controls and reposition it, if you wish:

We now need to apply the settings from the moving plane to the contact surface.

18. Double-click on the contact surface in the project tree.

19. Click on the Trend tab.

20. Click the Set From Plane button to copy the plane settings:

This copies the moving plane settings to the Trend tab.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

l The Maximum value is the relative strength in the direction of the green line on the
moving plane.

l The Intermed. value is the relative strength in the direction perpendicular to the green
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line on the moving plane.

l The Minimum value is the relative strength in the direction orthogonal to the plane.

To emphasis the vertical trend, we can change the Intermed. value.

21. Set the Intermed. value to 6.

22. ClickOK.

When the surface is reprocessed, it should appear similar to this:

Now that we have adjusted the Mineralised potassic alteration surface, we can use the same
plane settings to adjust the Porphyry stock surface.

23. Clear the scene.

24. Add the Porphyry stock surface to the scene.

25. Double-click on the contact surface in the project tree.

26. Click on the Trend tab.

27. From the Set to list, select the trend settings used for the Mineralised potassic alteration
surface:
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28. ClickOK.

Once the surface is reprocessed, it should appear similar to this:

29. Clear the scene.

30. Double-click on the Surface Chronology.

31. Enable each of the intrusions and clickOK.

32. Add the geological model to the scene.

The model should appear similar to this:

Modelling the Younger Alterations
In Analysing the Data, we saw that the younger alterations form relatively flat layers. In this
step, we will model themas deposit and erosion contact surfaces. The remaining lithologies are:

l Sericitic alteration

l Chloritic alteration
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l Advanced argillic alteration

l Acid leached zone

We will model these lithologies using alternating erosion and deposit contact surfaces. First, we
will model the Sericitic alteration contacts as an erosion.

1. Right-click on the Surface Chronology object and select New Erosion > From Base
Lithology.

2. In the window that appears, select Sericitic alteration.

3. ClickUse contacts below.

The younger lithologies should automatically appear in the Ignored lithologies list:

4. ClickOK.

5. Clear the scene.

6. Add the new surface to the scene.
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It should appear similar to this:

Next, we will enable the surface in the model.

7. Double-click on the Surface Chronology and enable the Sericitic alteration contacts surface.

8. ClickOK

9. Clear the scene.

10. Add the geological model to the scene:

Next, we will create a deposit contact surface for the Chloritic alteration lithology.

11. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology.

12. In the window that appears, select Chloritic alteration.

13. ClickUse contacts below.
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14. Move all lithologies into the Contacted/Avoided lithologies list except Acid leached zone
and Advanced argillic alteration, as these are younger than the surface we are defining:

For some of the lithologieswe have included in the Contacting/Avoided lithologies list, there
are no contactswith the Chloritic alteration lithology. However, if the drillhole data is updated,
there could be contacts between Chloritic alteration and these other lithologies. Because
Chloritic alteration is younger than these other lithologies, we need to move these lithologies
into the Contacting/Avoided lithologies list.

15. ClickOK.

16. Clear the scene.

17. Add the surface to the scene:
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18. Create an erosion contact surface for the Advanced argillic alteration lithology using these
settings:

l Select the Use contacts below option.

l Remove all lithologies except Acid leached zone from the Ignored lithologies list.

It should appear similar to this:

19. Right-click on the Surface Chronology and select New Deposit > From Base Lithology.

20. Select Acid leached zone as the primary lithology and select Use contacts below.

Aswith the Advanced argillic alteration contact surface, there are older lithologies for which
there are no contactswith the primary lithology. However, updating the drillhole data could
result in contacts between these younger lithologies and the primary lithology and we would
wish the model to reflect this. Therefore, we need to move older lithologies into the
Contacting/Avoided lithologies list.

21. Move all lithologies into the Contacted/Avoided lithologies list.

22. ClickOK.

The surface should appear similar to this:
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23. Double-click on the Surface Chronology.

24. Enable all the contact surfaces and clickOK.

25. Clear the scene.

26. Add the model to the scene.

It should appear similar to this:
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Tutorial 5: Building a Geological Model From a
Map

In this tutorial, we will create a geological model froman imported map using GIS lines and
structural data.

Data for this tutorial can be found in the Map folder.

Setting Up the Project
To start:

1. Launch Leapfrog Geo.

2. In the Projects tab, clickNew Project.

3. Enter the name “GM frommap” for the new project and clickBrowse to select a folder where
the project will be saved.

4. ClickOK to create the project.

The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing a Map and Setting the Clipping Boundary

First, we will import a map and use it to set the clipping boundary. The file is called Simple fault
and sediments.tif.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called Simple fault and sediments.tif, then click
Open.

3. Click Import to import the map.

4. Add the map to the scene and press the D key to view it fromabove.

5. Right-click on the Topographies folder and select Set Clipping Boundary.
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6. Adjust the red handles so the clipping boundarymatches the map’s border:

7. ClickOK.

Creating the Topography

As in Tutorial 2: Modelling Veins, we will create the topography froman elevation grid. The file
is called topo.asc.

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the topo.asc file and open the file.

3. In the Import Elevation Grid window, click Import.

4. In the New Topography window, clickOK.

Creating the Geological Model
To create the geological model:

1. Right-click on the Geological Models folder and select New Geological Model.

2. In the window that appears, clickOK to accept the default settings and create the model.

The new geological model will be created in the Geological Models folder. Because there is no
drillhole data in the project, we need to manually define the lithologies used in the model.

3. Double-click on the Lithologies object.
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4. In the Lithologies window, click the Add button to add a lithology:

5. Name the lithology Red.

6. Add two more lithologies, Blue and Green.

7. For each lithology, set the colour to match those in the map by clicking on the colour chip,
then using the eyedropper to pick the colour from the map displayed in the scene:

8. ClickOK to close the Lithologies window.

Creating the Fault
We will create the fault by drawing a GIS line and structural data points in the scene.

1. Clear the scene.

2. Add the topography to the scene.
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3. From the GIS data dropdown list, select the imported map from the Maps and Photos
submenu to view it draped on the topography:

4. Right-click on the GIS Data, Maps and Photos folder and select New GIS Line > From New
Drawing.

5. In the window that appears, name the line “Fault”.

The new GIS line will be created in the project tree and will be added to the scene. Drawing
toolswill be added to the scene window, and the slicer will be added to the scene to give the
drawn GIS line depth:

6. To start drawing, click on the Draw lines button ( ).

A set of tooltips appears in the scene:
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7. Follow the tooltip instructions to trace the fault in the scene:

8. Right-click to end the drawing of the fault, then click the Save button.

9. Remove the GIS line and the slicer from the scene.

Next, we will add the fault to the geological model, then edit it with structural data points.

10. Right click on the Fault System for the geological model and select New Fault > From GIS
Vector Data.

When the Fault Type is set to Surface, the drawn GIS line will appear in the list twice. The Fault
(On Topography) option automatically drapes the drawn GIS line on the topography.

11. Select the Fault (On Topography) object and clickOK.

12. Expand the Fault System in the project tree to see the new fault.

13. Right click on the fault and select Edit > With Structural Data:
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A structural data table will be created and added to the project tree as part of the fault object.
The table will be added to the scene for editing and the structural data toolbar will appear,
together with the Structural Data window:

14. Zoom in to one of the structural data points on the map.

15. Rotate the scene so that you are looking in the direction of the dip.

16. Change the plunge until it is about the same as the dip.

17. Click on the structural data point button ( ) and draw the data point in the scene. To do
this, click on the centre of the strike and dip, and drag to the right:
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Always drawing structural data points in the same direction ensures the polarities remain
consistent.

18. In the Structural Data window, manually enter the Dip value from the map:

19. Draw the second structural data point that occurs along the fault and edit its dip value.

20. Click the Save button.

21. To enable the fault, double-click on the Fault System.

22. Tick the box to enable the fault.

23. ClickOK.

The geological model has now been divided into two fault blocks, named “GM fault block 1”
and “GM fault block 2”:

We can rename these volumes to make themeasier to workwith.

24. Clear the scene.

25. Right-click on the geological model in the project tree and select View Fault Block
Boundaries.

26. Press the D key to view the model fromabove.
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27. Click on the eastern side of the geological model:

This shows that the fault block on the east is “GM fault block 1”.

28. Right-click on the fault block in the project tree and select Rename.

29. Rename the fault block “East”.

30. Rename the other fault block “West”.

Creating the Contact Boundary Meshes
The contactswill be created using GIS lines. We could draw them from the map, aswe did for
the fault, but for this step, we will import the GIS lines and use them to create meshes. We will
then edit each mesh using the structural data point for each contact boundary.

1. To start, clear the scene.

2. Right-click on the GIS Data, Maps and Photos folder and select Import Vector Data.

3. Select the four shape files and clickOpen:

l blue_green_east.shp

l blue_green_west.shp

l red_blue_east.shp

l red_blue_west.shp

4. In the Import GIS Vector Data window, clickOK.

5. ClickDon’t Filter Data.

The imported GIS lineswill be added to the GIS Data, Maps and Photos folder.

Next, we will create fourmeshes, starting with the blue_green_east mesh.

6. Right-click on the Meshes folder and select New Mesh > From GIS Vector Data.

7. In the window that appears, select the blue_green_east (On Topography) GIS line.

8. ClickOK to accept the other settings and create the mesh.

Next, we will add a structural data point to the mesh.

9. Add the topography to the scene.
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10. Orient the scene to draw the structural data point along the blue_green_east boundary.

11. Right-click on the mesh and select Edit > With Structural Data:

12. Zoom in to the structural data point on the map.

13. Click on the structural data point button ( ) and draw the data point in the scene.

14. In the Structural Data window, manually enter the Dip value from the map.

15. Click the Save button.

16. Repeat the above steps for each imported GIS line.

Adding the Contact Surfaces to the Geological Model
Now that we have created the GIS lines that represent the contact boundaries, we can start
adding contact surfaces to the geological model. The geological model has been divided into
two fault blocks, East and West, so we need to define the surface chronology for each fault
block. We will do thisworking from the oldest contacts to the youngest, which means that for
each fault blockwe will define:

l A Green-Blue surface

l A Blue-Red surface

1. Clear the scene.
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2. Right-click on the Surface Chronology for the East fault block and select New Deposit >
From Surface.

3. In the window that appears, select the blue_green_east (On Topography)mesh.

4. Set Blue for the First lithology.

5. Set Green for the Second lithology.

6. Ensure that First lithology is set to be younger than the Second lithology:

7. ClickOK.

Once the surface has been created, we can add it to the scene to check its orientation.

8. Add the contact surface to the scene.

9. Add the topography to the scene.

10. Orient the scene to see whether or not the colours assigned to each side correspond to
those on the map.
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If the surfaces is not oriented correctly, as in the image below, click the Swap Younging
Direction button:

11. Repeat these steps for each contact, creating the surfaceswest of the fault using the
Surface Chronology for the west fault block.

12. Add the four surfaces to the scene. They should appear similar to this:

If your results are not expected:

l Check that the surfaces are oriented correctly and change the younging direction, if
required.

l Edit the structural data point used to edit each mesh. To do this, expand the mesh in the
project tree. Right-click on the structural data table and select Edit In Scene.

Enabling the Contact Surfaces
Although the contact surfaces have been defined, we still need to enable them.

1. Double-click on the Surface Chronology for the East fault block.
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2. Enable both contact surfaces and clickOK.

3. Repeat the process for the West fault block.

4. Clear the scene.

5. Right-click on the geological model and select View Output Volumes:
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